Unit 12: Print Templates
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Questions Covered
•

Can we print a contract based on the information in a contract
record?

•

How do we create a document and attach it to a record?

•

What file types are available?

•

How can we create work orders, invoices, and purchase orders?
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Print Templates Unit Overview
•

In this unit we will learn how to set up a print template.

•

We will learn the different ways we can use print templates.

•

We will use an attached file action to create a document from a
print template and attach it to a field in a record.
You will need Word 2007 or later (or other word processing
software which can save files in the .docx file type).
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What are Print Templates?
•

Print templates are similar to email templates, but instead of converting record
information into an email, they convert information into a Word (DOCX), PDF, or
HTML document.

•

Like email templates, we have the opportunity to use field variables from the
record we are printing in order to produce dynamic documents.

•

Print templates can be used to create:


Physical letters



Invoices



Contracts



Work orders



Address labels



More…
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Uses for Print Templates
•

Print templates are used to:


Create a single document and attach it to a particular record, automatically or by clicking an
action button.




Example: Create and attach a legal contract based on fields in a record. The resulting contract
can be sent by an email action.

Create attached files in multiple records selected from the table view, using an action button
added to the action bar.


Example: When invoices are ready to generate for several customers, select the customer
records and click a “Generate Invoices” button.



Run a template from the table view or from an action button on a single record. The resulting
file is previewed on screen without automatically saving or attaching it anywhere.



Run a template from the table view on selected records, combining the output into a single
document that can be viewed or saved (without attaching it anywhere).


Example: Print address labels for multiple customers or print multiple letters to be sent to
customers at the close of each day.
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File Output: Word vs. PDF vs. HTML
•

Print templates can be created to output into three different
formats: Microsoft Word (DOCX), PDF, and HTML.

•

Both MS Word and PDF templates are created by uploading a MS
Word template file with the desired format.

•

However, the same MS Word template will generally look different
when output to Word vs. PDF.

•

HTML templates are created in HTML format.

•

Each method has its pros and cons, which are discussed over the
next few slides.
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Pros and Cons of MS Word Output
•

•

Pros:


Resulting document is fully editable (easier for staff users to revise).



Can include images.



Can make use of headers and footers.



Can include mathematical formulas based on field values from within
the record.

Cons:


Resulting document is fully editable (less secure) unless it is created
from a locked print template, in which case any changes made to it are
automatically redlined.
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Pros and Cons of PDF Output
•

•

Pros:


Resulting document is non-editable (more secure).



Can make use of headers and footers.

Cons:


Resulting document is non-editable (more difficult to revise).



Formatting is more difficult, some formatting is impossible.



The PDF converter does not recognize tabs as a way to align text; to
align text, it must be placed in a MS Word table with “clear” cell
bordering.
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Pros and Cons of HTML Output
•

•

Pros:


High level of control.



Can create barcodes.



Can insert images.



Can include mathematical formulas based on values within the record.

Cons:


Requires knowledge of HTML to set up template in an effective and
attractive manner.



Not a standard format for contracts and other common documents.
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Formatting Embedded Tables
•

There are two ways to format embedded tables within a print template.

•

The first way is to insert the field variable name for the related table and
allow the program to use the default view to define the columns and
their formatting.


•

This method works for PDF templates, but if the table is too wide, it may
truncate some data.

The second, more customizable way is to define the table within Word
using Word formatting, with one or two rows and your own column
headings.


This method works well for Word and HTML templates.



This method also works for PDF, but special formatting other than border
formats will be lost (for instance, alternating row colors).
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Automatic Table Formatting
•

If we want the program to do the formatting for us, as described in
the first method on the preceding slide, we simply insert the field
variable name onto its own row in the template:


$formula($related1231231231)

•

In this case, the program generates the table according to the
default view for the embedded table, with automatically
calculated cell widths. If the view defines certain fields as being
right-aligned, they will be right-aligned in the printed output.

•

We will look at custom formatting a little later.
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Fixed vs. Variable Templates
•

Print templates may be defined to use a hard coded file uploaded
from a local source as the template, or they may use a file in an
attached file field within a record as the template.


If all records will use the same print template, select the File option
and upload the template.



If different records will use different templates, select the field that
will hold the relevant template for this record. Any file field, including
linked fields from other tables, may be used.
Template
-'File

Choose File No file chosen

No file uploaded
•' Field | Print Template File

Choose one
Doc Type Fixed Attachment
Print Template File

| Transitional Files
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Variable Templates (continued)
•

In many business applications, different document types or contract types require
their own print format. For this reason, we commonly use a print template held in an
attached file field, rather than a single hard-coded template uploaded in the Print
Template wizard.

•

In this case, the attached file field (containing the print template) must be part of the
table where the print template is run, either as a native field or as part of a linked set
from another table.

•

For example, in a typical contract management scenario, the Contract Types table has
a Print Template File field. This field stores the relevant print template, either as a local
field or a link to another table that stores all available print templates.


•

On the Contracts table, selecting the Contract Type also pulls in the Print Template File field as
part of that linked set.

A single print template configuration can then be used for contracts: the linked Print
Template File field is identified as the template source. Then for each contract,
whatever file is held in that field is used to generate the output file.
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Merging Multiple Files and/or Templates
•

Print templates can be created from, or augmented by, one or more attachments
held within a record.

•

Using the $merge($fieldname) command within the print template will merge all
attached .docx/.html files from the field $fieldname in the current record into the
resulting print template’s .docx file.


•

It is also possible to merge multiple documents held in separate file fields by
using the format: $merge($fieldname1) $merge($fieldname2)
$merge($fieldname3) … $merge($fieldnameN).


A

Documents held in a versioned file field will be merged in the order in which they were
uploaded or appended to the field.

This makes it possible to compile a large PDF or Word document from several attachments.

The $merge command must be placed within the body of the print template. This
function will not work if the $merge function is placed within a table or within
the header/footer of the template.
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Managing Print Templates
•

Print templates are accessed through a table’s
action bar.

•

Mouse over the printer icon to bring up the print
template options.

•

From here we can create a New HTML Template
or New Word/PDF Template, manage our existing
templates, or select an existing template to run.

•

Let’s create a new print template.

•

Before we continue, download the file ProjectReport.docx, made
available within this unit.


We will be using this document as a starting point in our hands-on exercises.
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Download the Project Report
•

Navigate to the Project Report page in ProProfs.

•

Once loaded on your screen, click the small black arrow to download the file to
your desktop.
ProProfs
Training Makor
*

-

Page 1/1

PROJECT REPORT: SCOMPANYO_
Project Name: Sformula(Sproject_name)

Status: Sformula(Swfstate)
Sformula($project_category)/Sformula($project_type)

PROIECT DETAILS _
Project CCs: $project_ccs
Estimated Hours: Sestimated_hours

Project Description: $project_description
Target Completion Date: $target_completion_date

TASKS
<Find the Tasks related table field name variable and insert it here>
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+

Setting Up a Print Template
•

Open the file ProjectReport.docx and take a look
at how it is formatted.

PROJECT REPORT: $COMPANYO
Project Name: $

•

Note that it is set up similarly to the email
templates we created in Unit 7.

•

There is one change to make in the sample print
template before uploading it to the system.

PROJECT DETAILS

Because we added the Tasks related table in a
previous unit, the variable field name will be
specific to your Training KB.

Proje ct De scription: Sproiect descrip

•

A

Status: $formula($wf state)

Before moving forward, identify and update
the variable field name for the Tasks related
table so that it matches the variable in your KB.
It should look something like this:
Q

Tasks

related"! 404162716151

Project CCs:J

Estimated Hours: Sestimated hours

Target Completion Date: S

TASKS
<Find the Tasks related table field name variable and insert it here>

TIME AND BILLING
Hours Spent
Total Hours Spent: Stotal hours spent

$related!201905149296

relatedl 404162716151
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Linked data from another table

Practice

Creating a Word Print Template
•

•
•
•
•

There are two separate wizards for creating print
templates, one for Word/PDF templates and
another for HTML templates.
The wizards are straightforward, including layout,
format, and file information.
We will not cover the wizards in detail, but rather
dive right in.

'Title
Project Report

Create format in:
MS Word 2007+

PDF

u

>verride header height, 0

inches

Q

override footer height

[o

inches

Show Field Variables

Navigate to the Projects table, and mouse over the
printer icon.
When the options appear, select New Word/PDF
Template.

Download Template

Printout will be:
one page per record

— label format
Across

•

Title the template Project Report.

•

Select MS Word 2007+ as the format.

•

Select the option to print one page per record.

[2 pj Down [Auto ~|

Add borders around labels
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111

Practice

Creating a Word Print Template (continued)
•

Ensure that the option to Include column
headings in table is selected.

Table Column Headings
Include column headings in table
Include only table data without headings

•

Under Template, browse for, select, and
upload ProjectReport.docx.

□

•

Select the option to publish the print
template.

Template
*

•

Click Finish to save your print template.

•

This will bring you to the Print Templates
table.

•

Close this window to return to the Projects
table.

Expand table to fit page width

File

Mouse over the printer icon and note that
your print template is now visible.
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No file selected.

UJ Project Re port, do ox,23 672 Bytes
Field Choose one

Published
Yes

•

Browse...

No

Practice

Review the Print Template
•

•
•

Now that the print template is available for use, select a few of the
project records by marking the checkboxes to the left of the table view.

Once selected, mouse over the printer icon and click on the print
template we just created.
Depending on your browser, you may see an option to Open or Save
the file.

•

Select Open with… Microsoft Word (or other word processing software
which opens .docx files).

•

Open the file.

•

Review the document and how the field variable names translate to
the values from the corresponding records, paying special attention to
the related tables.
If your related tables are blank, make sure you select projects that have
at least one associated task.

-9-

If you selected multiple project records, they were output to a single
document using this method.
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±ii Projects
Status: 4 record(s) found, 1 pages Click here
New o} Mass Edit [jÿf Delete
Edit ID i

(Jj

Actions

Project Name

flS

20

Set up system for new customer:
Agiloft

Q

19

Vet system

\4 0

18

New Implementation

uS

17

Implement Project

imer

New HTML Template
New Word/PDF Template

)m

f

al r

© Project Report

Practice

Creating a PDF Print Template
•

Now that we know how to create a print template, let’s recreate the same template to output in
PDF format.

•

Mouse over the printer icon again and select New Word/PDF Template.

•

This time, select Create format in: PDF.

•

Upload the same file, ProjectReport.docx.

•

Once finished, select the same records from the Project
table, then print them out using the new PDF template.

•

Create format in:

Q MS Word 2007+
Vj; PDF

1_J Override header height 0

_

I

| Override footer height

0

inches

inches

Note the differences in formatting, including fonts, table formatting, etc.
Project Report: ExaGrid
XPra

PROJECT REPORT: EXACRID

St3tlJS. Pending

Status: Pending

Client-Related/General IT Project

Client-Related/General IT Project

J

Project Details

PROJECT DETAILS

Project CCs:
Estimated Hours: 120
Project Description: Implementation in progress

Project CCs:

Estimated Hours: 120
Project Description: Implementation in progress

Tarnfil finmnlotinn nath~ Nov 1? ?M4

/%r
Tasks

Target Completion Date: Nov 12 2014

TASKS
Task Type

Task Summary

Other
IT Related

Implement New...
Install New Server

Assigned
Person
Agiloft...

Agiloft...

Date Created

Date Due

Feb 07 2014...
Feb 07 2014...

Feb 09 2014...
Feb 09 2013...

Task Type

Task Summary

Other

Implement
New...
Install New
Server

IT Related
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Assigned
Person
Agiloft...

Date Created

Date Due

Feb 07 2014...

Feb 09 2014.

Agiloft...

Feb 07 2014...

Feb 09 2013...

..
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Custom Formatting Defined in Word
•

To use custom formatting in a related table, we will insert the related table variable
name. Directly below that, insert a Word table and include the field variable names for
each of the columns in the source table.
$formula($related1231231231)
Sitem_name
Sid

lid

•

$item_name

limit

Sprice

Squantity

$total_price

lunit

1price

1quantity

$total_price

There is an option in the Print Template wizard to include or exclude field labels in the
column headings.


If the template is set to include column headings, the system will use the format in the first
row of the table in Word to define the format of the column headings and the second (and
third) row to format the alternating data rows.



If the template is set to include only table data, excluding column headings, the system will
use the first row to format odd rows and the second row to format even rows.
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Custom Formatting Defined in Word (continued)
•

In the example below, we have a table with forced custom headers, meaning that the
system will ignore the format setting to include or exclude column headings. In this case,
the second row is used to define the format for odd rows and the third row will control the
format for even rows.
$formula($related1231231231)

•

ID

CUSTOM LABEL

$id

Custom prefix : Sitem_name

Sid

Custom prefix : $rtem_name

PRICE

NUMBER

SUM

$ u nit

Sprice

Squantity

$total_price

Sunrt

Sprice

Squantity

$total_price

To add summary data at the bottom of the table, we define a table with more than three
rows. The first three rows will define the format as indicated above; any additional rows will
define the format for summary data, including totals, subtotals, counts, etc.


When including summary items in the table, simply include the field variable name for a
calculation on multiple linked records which is derived from the embedded table in question.



For example, in the example above, we probably have a calculation field that gives the total of
the Total Price field. In this case, on the fourth row we would include that field name,
$total_items_price, in the Sum column.
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Practice

Add Custom Formatting to Our Print Template
•

Return to ProjectReport.docx.

•

We will create custom table formatting with
custom column headers for the Tasks related
table.

•

TASKS

In the Word document, place your cursor on
the line below the Tasks related table field
variable name and above the Time and
Billing header.

□

Srelated 1391805913185

TIME
Tie

|

AND

Insert

|

•B M
Page
Break

BILLING

Table

Page Layout

i
Pictuire

5x4 Table

•

Navigate to the Insert tab, and insert a table
of size 5x4.
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References
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Practice

Add Custom Formatting to Our Print Template
•

Clicking in the body of the table will bring up a yellow Table Tools tab at the top of window.
Selecting that tab, and then the Design tab, will bring up various table styles.
Project Report. d ocx - Microsoft Word

Table Tools
Layout

References

Mailings

Review

View

Developer

Design

Layout

•

Select one of the styles from the ribbon. To see more options, select the down-arrow in the
bottom-right corner.

•

Once you have selected a format that appeals to you, place your cursor in the top-left cell of the
table, and add the field variable names as below (use the actual field names from your KB if they
are different than those below).

-9-

Pay special attention to the cell widths. Don’t worry if the variables wrap.
Task Type

Task Title

$task_type

$task_summary

$task_type

$task_summary

Assigned Person Date
Created
$assigned_perso $date_cre
n
ated
$assigned_perso $date_cre
n
ated

TOTAL

Date Due
$date_due
$date_due
$number_of_tasks Tasks
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Practice

Test the New Templates
•

After saving the Word document, return to the Projects table. Create two
new print templates from the revised file, one in Word format and the
other in PDF.

•

Name your templates “Project Report – Custom Format.”

•

Select the same records from the Project table, and print them with both
of the new print templates.

•

Note the differences in formatting between them, paying special
attention to the drawbacks of using this method for PDF templates.
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Make a Word Document Non-Editable
•

•

We discussed earlier some of the pros and cons of Word vs PDF.


Word documents are generally editable, while PDFs are not.



There is a higher degree of control when formatting Word documents compared to PDFs.

There are cases where users may want a document to be editable until it has
gained final approval, and then non-editable once it has reached its final state.


For example: Contracts, FAQs, Internal Memos, etc. may go through an approval process
where it will be edited until final approval is given. From that point forward, the document
that is distributed or published is non-editable.

•

Unfortunately, it usually doesn’t work to use the same template to produce both
Word and PDF documents – they will come out different. Creating two separate
templates for each document is cumbersome.

•

How can we enjoy the best of both worlds?
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Protecting Word Documents
•

To make a Word document non-editable, use the Restrict Editing function on the Review tab
of Microsoft Word.

•

Once the Restrict Editing function has been selected, we are presented with a number of
options:


Limit formatting to a selection of styles.



Allow only certain types of editing:


Tracked changes.



Comments.



Filling in forms.



No changes (Read only).

•

Editing restrictions can be turned off with the use of a password.

•

By using a template Word document that allows only tracked changes editing, you can
ensure that all changes are noticed. Once ready to be finalized, a clean document can be
created by a person with access to the password, who accepts all changes.
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Attached File Action
•

As we discussed in Unit 10, attached file actions are used to automatically create
and attach a Word or PDF document to a record.

•

When the action is run, a print template is called upon and populated with fields
from the record, a file is created, and the file is attached to a field defined in the
action.

•

The Attached File Action wizard has only a single tab with the following options:


Action Name



Description



Format: Select which print template to use for the action.



Field: Define the target field (where the new file is attached), and whether to overwrite
existing files or append only.



Define the default file name: This is where we name our file. We can use a static title, or use a
formula to name the file based on values from the record.
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Practice

Create an Attached File Action
•

Before we can create our Attached File Action, we need to create a File with Versioning field to attach our
project report once created.

•

Navigate to the Projects table, and create the following fields:
Field Label

Data Type

Comments

Project Report(s)
Add Project Report

File with Versioning

Allow multiple files
Create and Attach using the Project Report
- Custom Format (word doc) Print
Template. Title: xxxxx. Save first, Save and
open for edit after.

Action Button

•

When you arrive at the Actions Library for the Add Project Report field, select Create Print Action.

•

Name the action “Add Project Report.”

•

Give your action a description.

•

Under Format, select the print template [WORD] Project Report – Custom Format.

•

Under Store printed document in the File Field, select Project Report(s) and select the option append the
file to this field.

•

Under Define the default file name, click Formula Help and select the variables and functions to create a
file name which looks like this:

•

Project ID $id : $project_name $date_updated
30

Practice

Create an Attached File Action (continued)
•

Click Finish to save the action.

•

When returned to the action library, check that our new action is selected. Click
Finish again to return to the Action Button wizard.

•

Complete the action button as we learned in Unit 8.

•

When finished, add the Project Report(s) and Add Project Report fields onto the
layout.

•

Once the fields are on the layout, return to the Projects table and edit one of the
project records you printed earlier.

•

Test your new action button to generate a report from the print template. Once
the Project Report(s) field has been populated with a Word document, open the
file to see how it looks.

•

This concludes our print template practice exercises.
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Using Field Variables from Linked Records
•

In addition to fields in the table where the print template is run, fields from any linked
record may also be inserted into the print template.

•

A chain of linked record relationships can be used to reach fields from a table
separated from the source table by several degrees. For example, suppose the
following structure:


A support case record has a submitter, linked to the people (contact) record.


The submitter’s user record is linked to their company record.
•

The company record is linked to a single support contract in the Contract table. The Type of
Contract field is pulled into the Companies table as part of a linked set.

•

You want to print out the support case and show the Type of Contract for the
submitter’s company. Suppose the only linked field in the Support Case table is the
Submitter ID.

•

By using a chain of linked fields, you can pull in any information linked to that
submitter, including information from the parent company’s record, the company’s
linked support contract, and so on.
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Building Field Variable Chains through Linked Records
•

$submitter_id is the field variable on the Support Case table.

•

Use the syntax $submitter_id.<fieldname> to pull in any field from the
submitter’s user record (i.e., the specific person record linked to the support case
by the submitter’s ID).

•



$submitter_id.phone_number will pull in the submitter’s phone number from their Person
record.



$submitter_id.company_name will pull in the company name, assuming these field names are
correct.

On the People table, the Company ID field links to the Companies table. Now we
can build a chain that begins $submitter_id.company_id. to pull in any field from
the company record into a print template running on the Support Case table.


$submitter_id.company_id.support_contract_type will insert the support contract type for the
support contract linked to the company linked to the submitter.
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Building Field Variable Chains (continued)
•

Each link in the chain must identify a unique record. For simplicity
we recommend using an ID field for each intermediate step.

•

The last field in the chain is not restricted, however. The final field
in the destination table can be a related table, choice field, or
other data type.
The variable chain feature for print templates is available in
Release 7.0 (2014_02).
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Displaying Dollar Amounts in Print Templates
•

The dollar sign symbol ($) indicates a variable or formula to the template engine.
This creates a formatting problem when writing non-variable dollar amounts in
the body of a template.

•

For example, imagine you wish to write an amount, say one hundred dollars, in
the body of the print template.

•



If we write $100, the system looks for the variable $100. If not found, the entire string ‘$100’
is removed from the template’s output.



If the amount listed is $1,250, the system will remove everything up to the comma, leaving
‘,250’ in the output.

To override this feature, use $$ (two dollar signs) to escape the variable in front
of dollar amounts. For example:


•

The unit cost is $$100, payable at the time of delivery.

The print template output will display:


The unit cost is $100, payable at the time of delivery.
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In-Line Calculations
•

If desired, you can perform in-line calculations in a print template using
standard operators and syntax (* for multiplication, / for division and so on).

•

For example, in a KB with appropriately defined fields, the following formula
can be used to calculate a sub-total for discounted units.


$formula($unit_price*$number_of_units*$discount_percentage)

•

Since this calculates a price, we want to also display a dollar sign in front of
the calculated amount.

•

We learned that ‘$$’ displays a single dollar sign, so we will add that in front
of the formula expression:


$$$formula($unit_price*$number_of_units*$discount_percentage)



The output of the formula will be $XXX, where XXX is the calculated total.
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Print Templates Unit Summary
•

In this unit we learned how to use and set up print templates.

•

We practiced creating print templates with different formatting
options.

•

We observed the differences in formatting between Word and PDF
templates.

•

We created an action button using the attached file action.
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